Photorealistic Rendering Techniques in AutoCAD

David Cohn – 4D Technologies

AC6769 Do you want to create professional-looking renderings? In this class you will learn how to convert your 3D AutoCAD software models into finished, photorealistic renderings using tools already built into AutoCAD software. You will learn how to use AutoCAD software’s lighting, material, and rendering tools to place and control lights; add and adjust materials and textures; and control the surrounding model environment to produce eye-catching images. You will also discover how to take real-world objects and quickly create custom materials, as well as produce reusable models of light fixtures that behave like real-world lights. You will learn how to capitalize on the Autodesk 360 cloud-based rendering service to create beautiful renderings quickly and easily, and you will even discover how to produce rendered animations entirely inside AutoCAD software.

Learning Objectives
At the end of this class, you will be able to:
- Add lights and model actual light fixtures
- Attach and modify materials and create custom materials
- Control the rendering environment to simulate natural lighting and atmospheric effects
- Render on your computer or in the cloud

About the Speaker
David is the Technical Publishing Manager at 4D Technologies, where he develops the CADLearning® courses and eBooks for AutoCAD and other Autodesk, Inc. products. He has more than 30 years of hands-on experience with AutoCAD software and 14 years with Revit software as a user, developer, author, and consultant. He is both an AutoCAD and Revit Certified Professional. A contributing editor to Desktop Engineering magazine, David is also the former senior editor of CADalyst magazine and the author of more than a dozen books about AutoCAD software. A licensed architect, David was also one of the earliest AutoCAD third-party software developers, creating numerous AutoCAD add-on programs. As an industry consultant, David has worked with many companies, including Autodesk. He has taught college-level AutoCAD courses and has consistently been a top-rated speaker at Autodesk University.

david.cohn@cadlearning.com
www.cadlearning.com
Rendering creates a 2D image based on your 3D scene. It shades the scene’s geometry using the lighting you have set up, the materials you have applied, and environment settings such as background and fog.

There have been rendering tools in AutoCAD for many years, enabling users to create realistic images incorporating materials, multiple light sources, and entourage objects such as trees and people. Those tools were updated significantly beginning with AutoCAD 2007, including the addition of photometric lights, more realistic sun and sky backgrounds, procedural material maps, a Materials Library shared with other Autodesk applications, and new tools for working with those materials. AutoCAD also uses the mental ray® rendering engine, the same rendering engine as 3dsmax®.

If you have used the rendering tools in older versions of AutoCAD, the modern tools may at first seem to be much different. But in reality, most of the new tools work in a similar fashion to those in older versions. More importantly, the modern rendering tools are easier to work with and most users can simply select a rendering preset to quickly create finished renderings. There are also commands that make it easy to walk or fly through your models.

While working, AutoCAD can display models with realistic materials, lighting, and shadows (depending on the current active visual style). A visual style is a collection of settings that control the shading and display of edges in the viewport. Instead of using commands and changing system variables, you can change the appearance of the model by simply selecting a different visual style. As soon as you apply a visual style or change its settings, you see the effect in the viewport.

AutoCAD comes with ten pre-defined visual styles—2D wireframe, Conceptual, Hidden, Realistic, Shaded, Shaded with Edges, Shades of Gray, Sketchy, Wireframe, and X-Ray—and you can create and add your own custom visual styles. When you select the Realistic visual style, AutoCAD displays your model with materials and shadows. Rendering adds more realism to those materials as well as showing reflection, refraction, and the true effects of lighting.

If you have worked with rendering in older versions of AutoCAD, you will also notice other changes, most of them for the better (such as being able to adjust lights using properties and grips). But some of the changes may prove a bit daunting at first. Lights and materials are considerably different from versions prior to AutoCAD 2007. If you are working with older drawings that contain lights and materials, you can convert them to the new type:

- CONVETOLDLIGHTS converts older lights to AutoCAD 2007 format
- CONVERTOLDMATERIALS converts older materials to AutoCAD 2007 format

Note that procedural materials and material mapping settings do not migrate. Also, some material features are no longer supported, such as material by ACI (AutoCAD color index) association. In addition, the pre-2007 commands for creating and inserting landscape objects—LSNEW, LSLIB, and LSEDIT—are no longer included in AutoCAD.
Rendering Basics

Rendering can be a very time-consuming aspect of a project. Because of the subtleties involved, you can spend a lot of time adjusting camera positions, lighting, and materials. In the past, you might spend more time creating a rendering than you spent actually building the 3D model. In addition, when you work with multiple light sources, each of which casts shadows, the computer calculations require a considerable amount of horsepower. Again, the good news is that the new tools in AutoCAD can help shorten this process, because you can now preview many aspects of your final image before actually creating a rendering. And as in previous versions, you can do initial renderings at lower quality settings or render just a portion of the final image, to test your changes before creating a final high-resolution rendering.

The process of creating a computerized rendering involves four steps:

- Create the actual model
- Place lights
- Attach materials to objects in the model
- Render the image

Other than creating the model, these procedures are conceptual rather than discrete sequential steps, and often are performed in an iterative process. For example, you may place some lights and create a test rendering. Then, after viewing the results of your test, you may change some of the lights and render the image again.

All of the tools used to place lights, work with materials, and create rendered images are located on the Visualize tab of the ribbon. This tab appears automatically when working in the 3D Modeling and 3D Basics workspaces, but can also be activated when working in Drafting & Annotation workspace.
The Render Panel

The Render panel appears on the Visualize ribbon and initially displays in its collapsed state. In this state, you can render an entire view, render a cropped portion of a view, select a render present, and render to a file. A rendering progress meter, also found in the Render Window, displays how far rendering has progressed. You can also open the Render Presets Manager where you can create or alter custom render presets and display the Advanced Render Settings palette to adjust more advanced settings. By expanding the Render panel, you gain access to tools to adjust the render quality, control the resolution of the rendering, adjust the exposure, display the Render Environment dialog box where you can set fog and depth of field effects, and display the Render Window.

Working with Lights

Placing lights in your model quickly adds a new level of realism. The combination of carefully placed lights and realistic materials turns a flat, shaded image into a close approximation of reality.

When you work in a viewport with a 3D shaded view, the default lighting comes from two distant sources that follow the viewpoint as you move around the model. All faces in the model are illuminated so that they can be seen. You can control the brightness and contrast, but you do not need to create or place lights yourself. In fact, the default lighting must be turned off in order to display lighting from user-created lights or the sun.

You can place lights into the model using the tools in the Lights panel on the Visualize ribbon.

User-Created Lights

For more control over lighting, you can create point lights, spotlights, web lights, and distant lights to achieve the effects you want. Note that when you place your first light into a drawing, AutoCAD displays an alert dialog to let you know that the effects of lights cannot be displayed in a viewport until you turn off the Default Lighting.

After placing lights, you can move or rotate them with grip tools, turn them on and off, and change properties such as color. The effects of the changes you make are immediately visible in the viewport.

Spotlights, point lights, and web lights are each represented by a different light glyph. Distant lights and the sun are not represented by glyphs in the drawing because they do not have a discrete position and affect the entire scene. You can turn the display of light glyphs on and off while you work. By default, light glyphs are not plotted.
The appearance of light glyphs is controlled from the **Light Glyph Appearance** dialog box, accessed by clicking the **Light Glyph Settings** button on the **Drafting** tab of the **Options** dialog box.

For more precise control over lighting, you can use **photometric lights** to illuminate your model. Photometric lights use photometric (light energy) values that enable you to more accurately define lights as they would be in the real world. For example, you can specify that a light uses a 75W bulb and adjust the lamp intensity of the bulb in Candela, Lumen, or Lux units.

Photometric lights were introduced in AutoCAD 2008. You can choose the type of lights by selecting from the drop-down list at the bottom of the expanded Lights panel. You can select International, American, or Generic lighting units (generic being the default type of lights used in AutoCAD 2007 and earlier).

When placing standard lights, you can specify that the intensity of light diminish over a distance, with the attenuation specified as the inverse of the linear distance from the light or the inverse square of the linear distance from the light, or that the intensity not diminish at all. The intensity of light from photometric lights always diminishes over a distance according to the inverse square of the distance. Lights created in AutoCAD 2008 and newer are now photometric by default, and International lighting units are selected by default.

### Placing User-Created Lights

When you add lights to a model, you can choose the type of light by selecting from the **Create Light** split button. You use this tool to create point lights, spot lights, distant lights, or web lights.

- **Point Light** A *point light* radiates light in all directions from its location. Point lights are useful for general lighting effects.

  To create a point light, on the **Visualize** ribbon, in the **Lights** panel, expand the **Create Light** split button and choose the **Point** light tool (or use the `POINTLIGHT` command). If this is the first light you are placing, you will need to turn off the default lighting before you can see the effect of this light.

  The program then prompts you to specify the source location. You can click to select a point or specify coordinates. Since you are working in 3D and most likely want the light source to be placed somewhat above the objects in the model, it is often easier to move the cursor...
until you locate a point on the XY-plane, then press the **TAB** key twice to make the Z-coordinate active, specify a Z-coordinate value, and then press **ENTER**.

Once you specify the location of the light, there are a number of options. You can assign the light a name, control its intensity factor, use the Status option to turn the light on or off, set the photometry value of the light, control whether the light casts shadows or not, adjust the attenuation, and control the color of the light. Since you can easily adjust any of these values later, it is usually easiest to simply press **ENTER** to exit from the command. AutoCAD will automatically assign a name to the light (such as Pointlight1). As soon as you add the light, you can immediately see its effect on the model. You also see the point light glyph.

- **Spot Light**  A *spot light* emits a directional cone of light. It casts a focused beam of light, like a flashlight, a follow spot in a theater, or a headlight. The light in the central portion of the cone is typically brighter than the light around the edges of the cone. You can control the direction of the light and also adjust the angle that defines the size of the central portion of the cone, or *hotspot*, as well as the angle that defines the outer extents of the cone, or *falloff*. The greater the difference between the hotspot and falloff angles, the softer the edge of the light beam. If both values are nearly equal, the edge of the light beam is sharp. Values can range from 0 to 160 degrees. Spotlights are useful for highlighting specific features in areas of your model.

To place a spot light, on the *Visualize* ribbon, in the *Lights* panel, expand the *Create Light* split button and choose the *Spotlight* tool (or use the SPOTLIGHT command). If this is the first light you are placing, you will need to turn off the default lighting before you can see the effect of this light.

![Spotlight Diagram](image)

The program then prompts you to specify the source location, and you can use methods similar to those described for placing a point light. But after specifying the source location, the program prompts you to specify a target location. Since spot lights emit a directional cone of light, you must specify both the location of the light itself and where you want it to shine. Once you have specified both points, the program prompts for a number of additional options, similar to those for a point light. Again, it is often easier to simply press **ENTER** to exit from the command and then adjust these values later if necessary. AutoCAD will automatically assign a name to the light (such as Spotlight1). As soon as you add the light, you can immediately see its effect on the model. You also see the spot light glyph.

- **Distant Light**  A *distant light* emits light that travels in parallel rays in one direction and does not diminish over distance; it is as bright on each face it strikes as it is at the source. You specify a From point and To point anywhere in the viewport. There is no glyph to represent a distant light in your drawing. Distant lights are useful for uniformly lighting objects or a backdrop. But distant lights are not physically accurate. For that reason, if you try to insert a distant light when the lighting is set to American or International lighting units, or switch from Generic lighting units to one of these photometric light units after a distant light has been placed in the drawing, AutoCAD displays a warning.
To place a distant light, on the Visualize ribbon, in the Lights panel, expand the Create Light split button and choose the Distant light tool (or use the DISTANTLIGHT command). If this is the first light you are placing, AutoCAD will display an alert to let you know that you must turn off the default lighting before you can see the effect of this light.

But as soon as you turn off the Default Lighting, AutoCAD displays a second warning, informing you that distant lights may result in overexposure when the lighting units are photometric. You can either disable distant lights when the lighting is photometric, or allow distant lights. Although Disable distant lights when the lighting unit is photometric is the recommended choice, if you click that option, the command will end.

The program then prompts you to specify the light direction from and to points. After specifying both points, the program displays a number of additional options, similar to those for point and spot lights. You can press ENTER and adjust any of these values later. AutoCAD will automatically assign a name to the light (such as Distantlight1). As soon as you add the light, you can immediately see its effect on the model, but unlike point and spot lights, distant lights do not have light glyphs. So you will not be able to select the light in the model in order to modify it. Instead, you can click the small arrow in the lower-right corner of the Lights panel to display the Lights in Model palette. You can select a light in the list and then right-click and choose Properties to modify the light using the Properties palette. When selected, you can also use gizmos to move and rotate distant lights.
Photorealistic Rendering Techniques in AutoCAD

- **Weblight** A *weblight* is a 3D representation of the light intensity distribution of a light source. Weblights can only be created when the lighting units are set to International or American lighting units. Weblights can be used to represent non-uniform light distributions derived from data provided by manufacturers of real-world lights. This gives a far more precise representation of the rendered light than either spot or point lights are capable of producing.

![Photometric data depicted using a peniometric diagram](image1.png)

![3D representation of light distribution](image2.png)

![A typical weblight](image3.png)

This directional light distribution information is stored in a photometric data file in the IES format using the IES LM-63-1991 standard for photometric data.

AutoCAD comes with several web lights, which have photometric data files already attached. These predefined web lights can be found in the **Tool Palette**. You can also place a weblight into the model and then attach a photometric data file you obtain from a lighting manufacturer using tools in the **Properties** palette.

You can load photometric data files provided by various manufacturers under the **Photometric Web** panel in the **Properties** palette for the light.

To place a weblight using the **Weblights** tool, expand the **Create Light** split button and choose the **Weblight** tool. If this is the first light you are placing, AutoCAD will display a warning and you will need to turn off the default lighting before you can see the effect of the light.

The program prompts you to specify the source location and then prompts for a target location. Since weblights can be directional, you generally have to specify both the location of the light and the point at which you want it to shine, although the predefined web lights in the **Tool Palette** may skip this step. After specifying these points, the program displays a number of options similar to those when placing other types of lights, and it is usually easier to skip these and make any necessary changes later. As soon as you add the light, you immediately see its effect on the model. If you insert a predefined weblight, you may not see any of these options. If the weblight already has an IES file attached to it, most of these options will be determined by the values in the data file.
Each inserted weblight has a glyph. If the weblight has an IES data file attached, the appearance of the glyph reflects the specific light distribution pattern of the weblight. If the weblight does not yet have an IES data file attached, it will have a generic weblight glyph.

You can select a weblight and display its properties in the Properties palette. In the Properties palette there is also an area called Photometric Web. If the weblight does not yet have an IES data file attached to it, this area will be blank. If you click in the Web File field and then click on the adjacent button, AutoCAD displays a Select Web File dialog. You can then locate the IES file you want to attach to this light. When you select an IES file, you can see a preview of its light distribution diagram.

Once you attach an IES data file, you will see this same light distribution diagram in the Photometric Web area in the Properties palette. And when you render a model that contains weblights, the lighting looks very realistic. Rather than a perfectly round hot spot and falloff, it has the sort of shape you would see if the light was coming from a real world light fixture.
Working with Sunlight

You can enable sun light to light your model using a special light that simulates the effect of sunlight. Sunlight can also be used in conjunction with sky simulation to provide a dramatic background and show how the shadows cast by a structure affect the surrounding area.

The rays of the sun are parallel and have the same intensity at any distance. The angle of the light from the sun is controlled by the geographic location you specify for your model and by the date and time of day. Unlike other light settings, all of the settings for the sun except for the geographic location are saved per viewport, not per drawing. The geographic location, however, is saved per drawing.

The sun and location properties are controlled using tools in the Sun & Location panel on the Visualize ribbon. To enable sunlight within your drawing, click the Sun Status tool.

As with other lights, if sunlight is the first light you are placing, AutoCAD will display an alert and let you know that you must turn off the default lighting before you can see the effect of the sunlight. Once you turn off the default lighting, however, the lighting in the model immediately changes. The model looks very dark in spite of the fact that the sun is now supposedly shining. That is because you have not yet established the location of the model.

To set the location, expand the Sun & Location panel and expand the Set Location tool. You can choose either From Map or From File. If you choose From File, you can import a KML or KMZ file. If you choose From Map, AutoCAD will display a dialog box asking you if you want to use Live Map Data. If you do not click Yes, you will not be able to use a map to specify the geographic location. In order to use live map data, however, you must be signed into your Autodesk 360 account. If you have not yet signed into your Autodesk 360 account, the program displays an Autodesk 360 Sign-In dialog.

Once you have signed into your Autodesk 360 account, the program displays the Geographic Location dialog. Initially, this dialog shows the entire world. You could click to specify a location on the map, but it is much easier to search for an address or a latitude and longitude.
Photorealistic Rendering Techniques in AutoCAD

Notice that selecting the location also sets the time zone. Once you find the desired location, use the tools in the dialog to place a pin on the map corresponding to the location and then click **Continue**. The program then prompts you to **Select a point for the location**. After specifying that point, the program prompts you to specify the north direction, or you could specify the angle. As soon as you do that, the command ends. A geolocation marker is displayed in the drawing at the point you specified and a map is applied to the drawing, below the drawing geometry. You can use the tools on the **Geolocation** ribbon to change the display of this map or toggle it off.

Now that the location and time zone are filled in, you can adjust the date and time by expanding the **Sun & Location** panel on the **Visualize** ribbon and adjusting the sliders.

Sun and sky are the primary sources of natural illumination in AutoCAD. Whereas the rays of the sun are parallel and of a yellowish hue, the light cast from the atmosphere comes from all directions and is distinctly bluish in color. When using photometric lighting, you can adjust the sky background and other sun properties.

In the **Sun & Location** panel, notice that the sky status is currently set to **Sky Off**. If you expand this split button, you can choose **Sky Background**, which turns on the sky background for rendering but leaves the sky illumination turned off, or choose **Sky Background and Illumination**, which turns on both the sky background and sky illumination computations for rendering.

If you render the scene with the sky off, the scene will be lit by sunlight, but the background will be black. If you render the scene with the sky background turned on, the sky will no longer be black, but there will be no illumination on the sides of objects facing away from the sun. If you turn on both the sky background and illumination, however, you will notice that it takes much longer to complete the rendering. In fact, you will see that the rendering engine makes several passes before it completes the rendering. But now, the sides of the objects facing away from the sun have become illuminated, because light has bounced around in the atmosphere so that it comes from all directions. Also notice that shadows are no longer harsh, and if you look
Photorealistic Rendering Techniques in AutoCAD

carefully, you can see that some of the color of the objects themselves has been reflected onto the ground, just as it would in the real world.

When you turn on sky illumination, AutoCAD uses a global illumination algorithm called radiosity to calculate the final rendering. Although this color bleeding may seem like a minor detail, if it is missing from a final rendered image, the image tends to look fake even though it may be difficult to point out exactly why.

When you turn on the sky background and illumination, AutoCAD also calculates the appearance of the sky and the sun, and the sun can even be included in the rendered image.

You can adjust the sky and sun settings. Click the small arrow in the lower-right corner of the Sun & Location panel to display the Sun Properties palette. Notice that here you can turn the sun on and off and control various sky properties, including atmospheric haze, the appearance and location of the ground plane, the amount of blurring between the ground plane and the sky, the color of the ground plane, and the color of the night sky. In the Sun Disk Appearance area, you can adjust the sun disk scale and glow intensity. And in the Sun Angle Calculator area, you can change the date and time.

Also notice that in the Sky Properties area, if you click the button on the Sky Properties bar, AutoCAD displays the Adjust Sun & Sky Background dialog. This dialog includes most of the same settings as the Sun Properties palette.
Using Luminaire Objects

You can embed lights inside blocks that also contain geometry, thus creating light fixtures that model both the physical and photometric properties of actual light fixtures. To do this, you would first model the light fixture in 3D, then place lights in the proper location within the light fixture model, and finally create a block containing both the 3D model and the lights. You could then place this block into other models.

When you render a view containing one of these luminaire objects, you can see that the light appears to actually be coming from the light fixture and both the properties of the lights and the shape of the light fixture models affects the appearance of the light.

By placing each light fixture on its own layer, you can use layer controls to try out different light fixtures. You can also save layer states with various views to quickly see what an image would look like with different light fixtures.

Note that when you create light fixture blocks like this, you can no longer turn individual lights on and off. To switch an individual light on and off or change its properties, you would need to go into the block editor in order to control the lights within the light fixture block.
Controlling the Location and Properties of Lights

With the exception of the sun and lights in blocks and xrefs, each light you add to the drawing is listed by name and type in the Lights in Model palette. You can easily modify lights similar to the way you would modify any other objects in a drawing.

With a light selected, in the Properties palette you can control any of its properties. Most are self-explanatory. Here are a few that are particular to lights:

- **Type** Specifies the type of light: point light, spotlight, or web light.
- **On/Off Status** Controls whether the light emits light when the default lighting is turned off.
- **Shadows** Controls whether the light casts shadows. To be displayed, shadows must be turned on in the visual style applied to the current viewport. If shadows cast by a particular light are not really visible in the finished rendering, you can speed up AutoCAD’s rendering calculations by turning shadows off for those lights.
- **Intensity** Sets a multiplier that controls the brightness. Intensity is not related to attenuation.
- **Filter Color** Sets the color of the light emitted as if it is passing through a colored filter.

In addition to these settings available for all lights, some lights provide additional settings. For example, you can control the attenuation (how light diminishes over distance) and use limits, which work like clipping planes to control where light is first emitted and where it stops. You can also control whether a light glyph is visible and plots or not.

With a light selected, you can also use gizmos to move or rotate a light and use grips to change where a light is shining. For spot lights, you can also use falloff and hotspot grips to change the appearance of the light.
Working with Materials

Attaching realistic materials to objects in your model truly brings those objects to life. By attaching materials, you make the flat surfaces appear to be made out of real brick and mortar.

You attach materials using the tools on the Materials panel of the Visualize ribbon and the tools in the Materials Browser.

AutoCAD comes with a library of hundreds of predefined materials and textures. That library is shared by all Autodesk programs that support materials. In order to utilize those materials and textures, you must install the material library. If you use multiple Autodesk programs, the materials library may have already been installed when you installed another program.

In AutoCAD, you can access all of the materials using the Materials Browser. To display the Materials Browser, click the Materials Browser button in the Materials panel on the Visualize ribbon. The Materials Browser behaves like any other palette in AutoCAD. The Materials Browser is divided into two main areas. The Document Materials area at the top shows all of the materials already loaded in the current drawing. This area will always include a Global material, which is the default material for all objects that have not yet been assigned a material. You can use tools in this area to filter the display of document materials. For example, you can show only those materials that have already been applied to objects in the drawing. You can also change the way materials are displayed, such as in a list or thumbnail view, change the thumbnail size, and change how materials are sorted.

The Library in the lower portion of the palette shows the materials library. By default, it includes the Autodesk Library and a Favorites library. You can also create and save your own custom material libraries. When you select a library on the left, you can see a list of materials in that library on the right. There are also controls to filter and adjust the display of these materials.

In order to use a material in a model, you must first add that material to your drawing. There are a number of ways to accomplish this. For example, you can locate a material in the Library and drag and drop it onto an object in the drawing. This applies the material to the object and adds it to the Document Materials area. You can also drag and drop a material from the Library into the Document Materials area to add that material to the drawing without actually adding it to any objects in the drawing.

You can also use the Search field to locate materials.

You cannot edit any material in the Autodesk Library. If you move the cursor over a Library material, you can see a lock icon. But once a material has been added to the Document, you can modify the copy of the material within the document and then save that version of the material to a user library. Tools at the bottom of the Materials Browser let you create, open, and edit user-defined libraries, create new materials in the current drawing, and open the Materials Editor.
Applying Materials to Objects and Faces

You can attach a material to an object, individual faces, or to all objects on a particular layer.

- To attach a material to an object, drag the material from the Materials Browser (either the Document or Libraries area) onto the object.
- To attach a material to an individual face, press the CTRL key while dragging the material from the Materials Browser onto the face of an object.
- To attach materials to objects by layer, use the Material Attachment Options dialog box (displayed by clicking the Attach By Layer tool in the Materials panel of the Visualize ribbon).

The left side of the dialog box shows the materials available in the current drawing. The list on the right shows the layers in the drawing. To attach a material to a layer, simply drag it from the list on the left and drop it onto the layer in the list on the right. The material is attached to all objects on the layer whose Material property is set to BYLAYER (the default). To remove a material from a layer, click the adjacent Detach button.

Creating and Modifying Materials

A material is defined by a number of properties. The available properties depend on the selected type of material. To create a new material, in the Materials Browser, click the Create New Material button. Note that the material you create will be added to the materials in the current drawing, not to a library. When you create a new material, you can choose the type of material you want to create, or create a generic material. Any of these choices will open the Materials Editor palette so that you can adjust the properties that define the material. The available properties depend on the selected type of material, whereas a generic material can include all of the properties.

The Materials Editor palette has two tabs. The Appearance tab contains the various property controls, whereas the Information tab lets you specify information about the material, such as a description and keywords. In the upper portion of the palette, you can control the type of preview used to display the material (a sphere, cube, cylinder, and so on). The first thing you should do is give the material a name. You can then specify material color options and use sliders to set properties for reflectivity, transparency, and so on.
Generic materials have a number of properties that you can use to refine your material, including:

- **Color**: specifies the color of the object
- **Image**: controls the diffuse color map by assigning an image or procedural image map
- **Image Fade**: controls the composite between the base color and diffuse image; only editable if an image is used
- **Glossiness**: controls the reflective quality of the material
- **Highlights**: specifies the specular highlights of the material

You can also toggle on and then control the following properties (or map channels):

- **Reflectivity**: controls the reflective quality of the material
- **Transparency**: controls the transparency of the material
- **Cutouts**: controls the perforation effects of the material
- **Self-Illumination**: controls the appearance that light is being emitted by an object
- **Bump**: controls the bumpy or irregular surface of the material

Rather than create a new material, you may simply want to modify one of the materials you have already added to the drawing. For example, perhaps you want a nice red oak floor. After adding the material to the drawing, you decide that you want smaller planks and want them to run across the width of the floor rather than along the length.

Many materials are based on images of actual materials. In this case, the oak flooring is based on an image of the actual flooring, assigned as a texture map. To modify the properties of such a material, you can edit the image of the material using the **Texture Editor**.

For example, to rotate the orientation of a material applied to a floor:
1. Open the material in the Materials Editor.
2. Open the image in the Texture Editor by either double-clicking on the image or selecting Edit Image from the Image drop-down.
3. Expand Transforms and then change the rotation angle by either moving the slider or entering a rotation angle.

Note that if you select Link Texture Transformations, any changes you make affect all linkable attributed. For example, if you rotate a texture map for a materials that also has a bump map, the bump map will also be rotated. If you clear this checkbox, any changes you make will only affect the particular map.

You can also adjust the scale to specify real-world units and the repetition of the image to tile the map horizontally and vertically.

**Using Texture Maps**

Images that are assigned to materials are called maps and can be used to improve the appearance and realism of materials. Materials that contain one or more images are called mapped materials.

Each material property or map channel can be assigned either an image map or a procedural map. For example, if you want a wall to appear to be made out of brick, you can create a material that has an image of the bricks assigned as its texture map. This is the most common type of mapping. You can use most common raster image formats to create texture maps, including BMP, GIF, JPEG, PCX, PNG, TGA, and TIF.

Maps can also be used to achieve other effects, and you can use more than one map for the same material. For example, you can use both an image map and a transparency map to create the appearance that portions of an object are transparent. Or you can add a bump map to make an otherwise flat object appear to have a bumpy or irregular surface.

Here is an example of how you can use maps to create a material that looks like individual raised letters for a sign.

First, create two images of the letters. The first one, using the actual color of the letters on a white background, will be the image map. The second, showing the same letters but with the letters in white against a black background, will be the cutout map. A cutout map creates the effect of partial transparency. White areas will appear opaque and black areas will appear transparent.

Open the Material Browser and create a new Generic material called “Hotel Sign.” In the Generic area, click in the Image field. The program displays a file open dialog. Select the image map file and click Open. AutoCAD immediately displays the Texture Editor.

Before adjusting the image map, select the Cutouts checkbox. As soon as you do, you again see a file open dialog. This time, select the cutout image and click Open.

Now you see the black and white cutout image map in the Texture Editor. If you click on the image map in the Materials Editor, you see the image map in the Texture Editor.
In the **Texture Editor**, select the **Link Texture Transforms** checkbox, so that any changes you make to one image map is automatically applied to the other. Then, in the **Scale** area, you will change the **Sample Size**. First, unlock the aspect ratio so that you can adjust the **Width** and **Height** separately and then set the **Width** to **2.25** and the **Height** to **0.75**.

Next, in the **Repeat** area, you need to change the way the material is mapped. Typically, materials such as brick need to fill the entire surface of the object onto which they are applied. But in this case, you only want one instance of the sign, so change both the **Horizontal** and **Vertical** settings from **Tile** to **None**.

Make just a few more adjustments. In the **Materials Editor**, in the **Generic** area, expand the **Highlights** drop-down and choose **Metallic** so that the letters appear to be made of a metallic material. Also select the **Reflectivity** checkbox so that the letters appear a bit reflective as well.

Now, all you need to do is to go to the **Materials Browser** and drag and drop the new **Hotel Sign** material onto an object. As soon as you do, you can see the sign in the model. Notice how it appears as if there are individual letters attached to the brick.
Procedural Maps

Procedural maps add further realism to a material. AutoCAD includes a number of procedural maps, including checker, gradient, marble, noise, speckle, tiles, waves, and wood.

Unlike texture maps, which use bitmap images, a *procedural map* is generated by a mathematical algorithm. As a result, the types of controls vary depending on the capabilities of the particular procedural map. Procedural maps can be generated in two or three dimensions and you can nest additional texture or procedural maps within a procedural map to add depth and complexity to the material.
Preparing Your Own Bitmaps

If you find that the Autodesk Material library does not contain a material that closely matches what you need, it is actually quite easy to create your own custom materials. Most common raster image formats—BMP, GIF, JPEG, PCX, PNG, TGA, and TIF—can be used as maps. You can capture images for use in creating new materials by scanning them or using a digital photo.

After capturing the image of the material, load it into a paint program and isolate a portion of the image so that it will tile properly without any obvious seams. You should also adjust the size of the image at this point so that it matches real-world units. Then, save that image.

One you have saved the image, you can use it as the basis for a new material. Back in AutoCAD, open the Materials Browser, create a new Generic material, and assign it a name. Then, click in the Image panel, select the image of the material you just saved, and click Open. In the Materials Editor palette, you can make any other necessary adjustments.

The key to creating your own material is ensuring that the material is the correct size when applied to objects in your model and making sure that the image will tile properly, without any unwanted seams, so that once it is applied to an object in your drawing, it extends seamlessly across the object.

Saving Materials to a User Library

When you create a new material or modify a material, that new or modified material only exists within the drawing in which it was created or modified. Remember that the materials in the Autodesk Library are locked—you cannot make changes to the materials library that comes with AutoCAD.

In order to use your custom materials in other drawings, you can save them to a user library. To add a material to the Favorites library, right-click on the material in the Document Materials list in the Materials Browser and then choose Add To > Favorites. Note that at this point, you could also add the material to the current active tool palette.

You can also create additional user libraries. To create a new user library, click the button in the lower-left corner of the Materials Browser. In the drop-down, you can open an existing library or create a new library. If you select the Favorites library, you can create a category within the Favorites library but you cannot remove or rename the Favorites library. If you create a new library, you can give it any name you want. You can then right-click on a material in the Document Materials list and add the material to either the Favorites or your new user library. Once you have added materials to a user library, you can use tools in the Materials Browser to create categories so that you can organize your custom materials into categories that you define. You can also rename user libraries.
If you no longer need to see a user library, you can choose **Remove Library** to remove it from the list of open libraries. The library still exists, but no longer appears in the list of libraries. To open it again, expand the tool, choose **Open Existing Library**, locate the library, and click **Open**. To delete the actual library file, use Windows Explorer.

**Adjusting Material Mapping**

After you attach a material with a texture, you can adjust the orientation of the texture map on the objects or faces. Material mapping adjusts the material to fit the shape of the object. Applying the appropriate type of material mapping to an object improves the fit:

- **Planar** maps the image onto the object as if it was projected from a slide projector onto a flat plane. The image is not distorted, but the image is scaled to fit the object. This mapping is most commonly used for faces.
- **Box** maps an image onto a boxlike solid. The image is repeated on each side of the box.
- **Spherical** warps the image both horizontally and vertically. The top and bottom edges of the bitmap are compressed to points at the north and south poles of the sphere.
- **Cylindrical** maps the image onto a cylindrical object so that the bitmap’s horizontal edges are wrapped around the object. The height of the image is scaled along the cylinder’s axis.

Suppose you are creating a rendering in which you need an image of a can of coconut milk. To prepare for this, you have removed the label from an actual can and scanned it using a scanner. You then save that as a bitmap image, create a new material, and apply that material to a cylindrical object in your model. But even after adjusting the image map so that it is the proper size and is not tiled, it still does not look right because the label is not properly wrapped around the cylinder. To fix this, in the **Materials** panel, expand the **Material Mapping** tool and choose **Cylindrical**. Then, select the cylinder representing the can and complete the command. The label now wraps properly around the can.

You can also use material mapping to move or rotate materials that have already been applied to objects. For example, if you wanted to change the orientation of flooring, rather than changing the rotation of the bitmap, which would affect all instances of the material within the drawing, you could rotate the material map for the single instance of the floor. To do this, expand the **Material Mapping** drop-down and choose the **Planar** map. The program prompts you to select faces or objects. Select the floor and then complete the selection. You could then choose the **Rotate** option and use a rotate gizmo to rotate the floor material or enter a rotation angle.
Creating a Rendering

Once you have built your model, attached materials to the objects in your model, and added lights to illuminate the scene, you are ready to create a rendering.

Creating a rendering in AutoCAD can be quite simple. Most of the tools you need to actually produce the rendering are located in the Render panel on the Visualize ribbon. For example, to create a rendering, you can simply click the Render button.

Before you do, however, you may want to select an appropriate render preset. AutoCAD comes with five predefined render presets: Draft, Low, Medium, High, and Presentation. Each of these presets applies a specific group of settings. As the names imply, each preset creates a rendering at a successively higher level of realism. And like most things in AutoCAD, you can modify the settings for each preset and create your own custom render presets, although most users find that these five presets provide more than enough options without any additional modification.

The other two tools that appear in the Render panel enable you to see the progress of the current rendering and save the renderings to a bitmap image file.

If you expand the Render panel, however, you will find additional controls that enable you to adjust the rendered quality of the model, adjust the render output size, adjust the exposure, control visual cues that help discern the apparent distance of objects, and display the Render Window.

And if you click the small arrow in the lower-right corner of the Render panel, AutoCAD displays the Advanced Render Settings palette, in which you can adjust all of the settings that control the creation of renderings.

But again, most users generally find that they can simply select an appropriate render preset, select the desired render output size, and then simply click the Render button.

By default, as soon as you click the Render button, the program displays the Render Window and you can see the rendering as it is created. Note that as rendering progresses, each little square represents a CPU processor core. The more processor cores and the faster the CPU in your computer, the faster your rendering will be created.

Once the rendering is complete, information in the Render Window shows you the output size, how long it took to render the image, which render preset was used, and other statistics about the rendering.
### Setting the Render Destination

When you create a rendering in AutoCAD, that rendering typically appears in the Render Window. But you actually have a choice. The rendering can appear either in the Render Window or in a viewport right within AutoCAD.

You can control the render destination from within the Advanced Render Settings palette. To display this palette, click the small arrow in the lower-right corner of the Render panel on the Visualize ribbon.

Under General, in the Render Context area, there is a setting called Destination. By default, this is set to Window, which means that AutoCAD’s rendering engine automatically opens the Render Window and the image is processed. Upon completion, the image is displayed in this window and a history is created. As more renderings are created, they are added to the render history so you can quickly look at previous images and compare to see which have the desired results. Images that you want to keep can be saved from the Render Window.

If you click in the Destination field, however, a drop-down becomes available. If you change this setting from Window to Viewport, the next time you create a rendering, the image is rendered and displayed in the active AutoCAD viewport. This is a one-time rendering, meaning that there is no render history entry that you can compare later. If you want to keep an image that you render to the viewport, you must use the SAVEIMG command. Otherwise, as soon as you do anything to cause the viewport to be redrawn, the rendered image disappears. Whereas, if you switch back to the Render Window, all of the previous renderings remain available until you close the drawing.

### Rendering Portions of What You See

You can render an entire view, a set of selected objects, or a portion of what you see in the viewport. By default, AutoCAD renders all of the objects in the current view.

But sometimes, when you are experimenting with materials or lights, you may not need to render the entire view. You can save time by rendering just a portion of what you see in the view, or even just selected objects.

To render a selected area within the view, expand the Render button and choose Render Region. AutoCAD will prompt you to pick the opposite corners of the area you want to render.

If you only want to render specific objects, in the Advanced Render Settings palette, under General, in the Render Context area, click the Procedure field to expand the drop-down and choose Selected. (Notice that you could also choose Crop.) The next time you click the Render button, AutoCAD will prompt you to select objects and only those objects you select will be rendered.

Note that when you change the Procedure, AutoCAD will continue to use the setting you choose until you change it again. Also, when rendering a region, the rendering always displays in the current viewport, not in the Render Window.
Setting the Render Output Resolution

You can set the resolution of the rendered image by specifying the width and height of the image, measured in pixels. The default output resolution is 640x480, but you can set the output resolution as high as 4096x4096 pixels. The higher the resolution, the finer the detail, but the image will take longer to render.

If you expand the Render panel, notice that you can expand the Render Output Size drop-down and choose from several predefined output sizes.

For complete control over the output resolution, click Specify Image Size. AutoCAD displays the Output Size dialog. Here you can also choose from one of the four predefined image sizes, or specify the resolution based on the number of pixels for the Width and Height. You can also control the Image Aspect ratio.

You can set a higher resolution than what your screen is capable of displaying in order to save a bitmap image that can then be printed as a high-resolution photograph or poster. Just remember that the higher the resolution—and the higher the rendered quality—the longer it will take to produce the rendering. If you are going to produce a lot of high-resolution, high-quality images, you may want to invest in a computer with a very fast, multi-core CPU, because the faster the processor and the more cores it has, the faster the images can be rendered.

Or, rather than spending money on a super-fast computer, you can use Autodesk 360 to upload drawings to the cloud and then render 3D views using Autodesk’s online rendering service.

Understanding Rendering Settings

Reusable rendering parameters are stored as render presets, and AutoCAD comes with five predefined rendering settings—draft, low, medium, high, and presentation—that can be selected from the Rendering panel on the Visualize ribbon. Each preset uses predetermined rendering settings, and you can easily create beautiful renderings without ever adjusting any of these settings. But you can also modify the settings used by any of these rendering presets, or create and save your own custom render presets, by using the controls in the Advanced Render Settings palette and the Render Presets manager.

For example, in the Advanced Render Settings palette, in addition to controlling things like the destination and output size, you can control whether materials are applied when rendering, the sampling rate, whether shadows are calculated or not and how they are calculated, whether ray tracing is performed when shading and how ray tracing is calculated, whether global illumination is calculated or not, and so on. You can adjust any of these settings prior to rendering. Any changes you make are retained and will be used when you render the scene, but will not be saved as part of a render preset.

You can also adjust render settings using the Render Presets Manager. To display the Render Presets Manager, expand the Render presets drop-down (either in the Render panel on the ribbon or in the Advanced Render Settings dialog), and choose Manage Render Presets.
Notice that this dialog contains the same parameters as found in the Advanced Render Settings palette. The panel on the left lists the predefined render presets. The panel in the middle shows the parameter settings for the render preset currently selected in the list on the left. And you can use the tools on the right to make a render preset the current preset, create a copy of an existing preset so that you can modify settings to create a custom render preset, or delete a render preset. Note that you cannot delete any of the five predefined render presets that come with AutoCAD.

Any new render preset you create will be listed in the Custom Render Presets branch and will also appear when you expand the Render Presets drop-down. But custom presets are only saved with the drawing in which they were created. You cannot export or import custom render presets. But if you want to have specific custom render presets available in other drawings, you can add custom presets to an AutoCAD template so that they will be available when you start a new drawing using that template.

Controlling the Rendering Environment

You can control the rendering environment to add fog and depth cueing, atmospheric effects that cause objects to appear to fade as they increase in distance from the camera. Fog uses a white color while depth cueing uses black.

To control the environmental settings, expand the Render panel and click the Environment tool. AutoCAD displays the Render Environment dialog. The controls in this dialog enable you to adjust the fog and depth cueing.

- **Enable Fog** Turns fog on and off
- **Color** Specifies the color of the fog
- **Fog Background** Controls whether fog is applied to the background
- **Near Distance** The distance from the camera to where the fog begins, specified as a percentage of the distance to the far clipping plane (cannot be greater than the Far Distance setting)
- **Far Distance** The distance from the camera to where the fog ends, specified as a percentage of the distance to the far clipping plane (cannot be less than the Near Distance setting)
- **Near Fog Percentage** Specifies the opacity of the fog at the near distance.
- **Far Fog Percentage** Specifies the opacity of the fog at the far distance.

If you render without any fog, you can clearly see everything in the resulting image (as shown in the image on the left). If you enable fog but do not add fog to the background, the objects in the rendering begin to disappear into the fog but the background remains unaffected (middle image), which is totally unnatural. But with Fog Background turned on as well, both the objects in the scene and the scene background image are rendered with fog applied (right image).
Working with Views

In addition to creating the model and adding lights and materials, an effective rendering also depends a great deal on what you see—and do not see—within the rendering. You can use any of AutoCAD’s view manipulation tools—pan, zoom, orbit, and so on—to get your view set up just right. In order to get back to those views, you can save them as named views. And when working with named views, you can include a background image, as was done in the previous example.

Placing Cameras and Creating Views

Sometimes it is difficult to use the pan, zoom, and orbit tools to set the precise view that you want to render. But there is actually a very simple and elegant solution to this. You can simply place a camera into your drawing so that you can see what the camera would see. Since most people have used a camera to take a picture, this metaphor works quite well.

The Camera tool is located in the Camera panel on the Visualize ribbon. But by default, this panel is not initially visible. So you will need to turn it on by right-clicking on any panel in the ribbon and choosing Show Panels > Camera.

Once the Camera panel is visible, there are only two tools: Create Camera and Show Cameras. You use the Create Camera tool to create and place cameras into the drawing, and the Show Cameras tool to toggle the visibility of camera glyphs on and off.

To place a camera into the drawing:

1. Click the Create Camera tool. As soon as you do, the program prompts you to specify the camera location, and you can see a camera glyph attached to the cursor.
2. Place the camera (use object snap).
3. Locate the target point (again, use object snap).
4. Enter additional options. (You can give the camera a name, change its location, change its height, adjust its lens, and so on.) Most users generally find it easier to accept the defaults and then make changes later.

After placing a camera, you can use Show Cameras to toggle the camera glyph. When you select a camera glyph, AutoCAD displays a Camera Preview window, showing the view seen by that camera. You can then expand the Visual Style drop-down and change the visual style used to display the camera view. If you click back in the drawing and move the camera or target location, that view immediately updates.
If you open the **Properties** palette, you can see and change any of the properties of the camera. For example, you could change the name, which will also change the name of the view. You can also change the **Lens Length**. This is the focal length of the lens, measured in millimeters, and most people who have used a camera are at least somewhat familiar with this value. A 50mm lens is pretty standard. A lens with a shorter focal length (smaller value) would be a wide angle lens and a lens with a higher value would be a zoom or telephoto lens.

As you change the **Lens Length**, the **Field of View** value also changes. A 35mm lens shows a 54-degree field of view. You could also simply adjust the **Field of View** value, or use the field of view grips in the model, but most users who have ever done any photography find it easier to work with the **Lens Length**. You can also adjust the **Roll Angle**, the **Front** and **Back** clipping planes, and turn **Clipping** on and off to limit what appears in the view.

If you open the **View Manager**, you can see the new camera view in the list of model views. And if you select the view, you can use the controls in the **View Manager** dialog to adjust the properties associated with the view.

**Adding a Background to a View**

You can add a background to a named view so that the background appears whenever the view is restored. That background is also included whenever you render the view.

A *background* is basically a backdrop that displays behind your model. Backgrounds can be a single color, a multi-color gradient, or a bitmap image. Backgrounds work best when you are rendering still images, or animations in which the view does not change very much.
Backgrounds are controlled using the View Manager dialog, and once set the background is associated with the named view or camera and saved with the drawing.

For example, to create a view in which you can see the landscape that would be visible through the windows of a room you have modeled, you could take a digital photograph of what would be visible through the window, and then associate that image with the view. To do this:

1. In the View Manager, select the named view to which you want to add the background.
2. Under General in the properties of the view, click in the Background parameter field, expand the drop-down, and choose Image.
3. In the Background dialog, click Browse, locate the digital photo, and click Open.
4. After loading the image into the Background dialog, click Adjust Image.
5. In the Adjust Background Image dialog, expand the Image Position drop-down and choose Stretch, so that the image is stretched to fill the entire background.
6. Click OK to close each dialog and complete the command.

When you restore the named view, it displays with the associated image. And when you render that view, the image appears as the background.

Saving and Redisplaying Rendered Images

Being able to see your images on screen is great, but you probably also want to be able to save a copy so that you can redisplay it again later, send a copy to a colleague, or print the image. Happily, there are several different methods you can use to save your renderings. Rendered images can be saved as BMP, TCX, TGA, TIF, JPEG, or PNG raster image files.

- **Saving a Rendering from the Render Window** If you render an image to the Render Window, you can save that image to a file by selecting it in the render history and then either choose File > Save or File > Save Copy from the drop-down (or right-click the image in the history and choose Save or Save Copy from the shortcut menu). The resulting image will have the same resolution as the output size listed in the render history.

- **Saving a Viewport Rendering** If you render to a viewport, you can save the image to a file by using the SAVEIMG command. The resulting image will have the same resolution as the viewport to which the image was rendered.

- **Rendering Directly to a File** You can bypass the screen and render directly to a file at any specified resolution. To do this, in the Render panel, toggle on the Render Output File control, then click the adjacent button to open the Render Output File dialog so that you can specify the name of the render output file before you begin to render the image. AutoCAD will then render the image and automatically save it to that file, in addition to displaying it in the Render Window.
Rendering in the Cloud

When you render an image on your computer, you cannot do anything else in AutoCAD while the rendering is being calculated. If your model is relatively complex, contains a number of light sources, or is being rendered at a high resolution or render quality, your computer may be unavailable for quite a while, even several hours. In the past, if you planned to do a lot of rendering, you would probably want to invest in a computer with a very fast CPU with lots of processor cores and lots of memory. But that is no longer necessary.

Rather than rendering on your local computer, you can use the resources and services available with your Autodesk 360 account to render 3D models online. When you do, the results can be available much sooner, rendering does not consume local processing power, images can be organized in your Autodesk 360 account and do not require local disk space, and images can be shared securely with people to whom you want to grant access.

The online rendering service provides the greatest value for 3D models that use lots of materials, textures, and photometric lights. And a free render preview option is available to help reduce errors that would otherwise require you to re-render a scene.

Rendering online is really quite simple. On the Visualize ribbon, in the Autodesk 360 panel, click the Render in Cloud button.

Note that if you are not already logged into your Autodesk 360 account, the program will display a sign in dialog. Once you sign in, if you have made any changes since you last saved the drawing, including simply changing the current view, the program will prompt you to save the drawing. Click OK.

Once the drawing has been saved, you will see a dialog informing you that your free preview renderings will appear in your Autodesk 360 account online. From there you can view, download, and share or fine tune render settings to create higher resolution final images, interactive panoramas, and more. If the drawing contains multiple views, you can choose to render all of the model views, the current view, or one of the named views. Notice that by default, the Notify me by e-mail when complete checkbox is selected so that Autodesk 360 will notify you by email when the renderings are complete.

Click Start Rendering. You will see a dialog informing you that the rendering job is being prepared. You will also see a balloon notification at the top of the screen, below the InfoCenter.

Once the renderings have been completed, you will receive an email from Autodesk 360, informing you that the image or images you requested are ready.

You can click on the link in the email message to open the Autodesk 360 Render Gallery in a web browser. Once you log in, you will be able to see a thumbnail image of the rendering. If you
click on the thumbnail, you can see the full version of the free preview rendering. You can also then use the other tools available in the Autodesk 360 Render Gallery.

Understanding the Render Gallery

The Autodesk 360 Render Gallery is the interface to the service you can use to render 3D models online. You can access the Autodesk 360 Render Gallery from within AutoCAD. On the Visualize ribbon, in the Autodesk 360 panel, click the Render Gallery tool. This will open the Autodesk 360 Rendering website.

Once you sign in to your Autodesk 360 account, you will see all of the renderings you have already created, arranged by drawing name. You can expand a drawing to see multiple images and click a thumbnail to see the full image.
Other tools enable you to re-render the image using new settings, so you can render at higher quality, or with different backgrounds. You can also download the image, delete the image, adjust the exposure, and so on. One of the advanced features of the Autodesk 360 Render Gallery is the ability to render a project as a panoramic 360-degree image.

Note that you can also switch to the New tab. Here you can upload a DWG or eTransmit ZIP file and render images of that file online. There are also several sample files that you can use to try out the rendering service.

Remember that your Autodesk 360 account is free and comes with 3GB of online storage and 75 cloud credits that you can use to create renderings. If you are on subscription, you get even more storage and more cloud credits you can use.

**Creating Walkthroughs and Flythroughs**

In addition to creating rendered still images, you can also create animated walkthroughs and flythroughs of your AutoCAD models.

The tools for creating animations are located in the Animations panel on the Visualize ribbon. By default, this panel is not initially visible, so you will need to turn it on (by right-clicking on any panel in the ribbon and choosing Show Panels > Animations).
This panel contains a number of tools. The **Walk** and **Fly** tools are quite similar. The only real difference is that when using the **Walk** tool, you travel along the XY-plane, whereas when you use the **Fly** tool, your movement is not constrained to the XY-plane, so you can appear to fly over an area of a model.

When you click to start the **Walk** tool, the walk mode becomes activated in the current viewport and AutoCAD also displays a **Position Locator** palette. By default, this palette shows your position in the drawing from a top view.

You may also see a balloon near the top of the screen, in the **InfoCenter** area, with information about how to move around when using the **Walk** tool. It explains that you can use keys on the keyboard to move within the viewport. You can use the **Up-Arrow** or **W** key to move forward, the **Left-Arrow** or **A** key to move left, the **Down-Arrow** or **S** key to move backwards, and the **Right-Arrow** or **D** key to move to the right. You can also drag the mouse to change the direction in which you are looking, or use tools in the **Position Locator** palette itself.

You can also use the controls in the **Walk and Fly Settings** dialog to adjust the default walk and fly settings, such as the step size and the steps per second.

While walking into a model can be quite interesting, this tool is much more useful when you record your movements. If you click the **Record Animation** button in the **Animations** panel and then use the **Walk** or **Fly** tools to move around in the model, AutoCAD will record all of your movements. Once you have reached a stopping point, go back to the ribbon and click the **Play**
The program opens an Animation Preview window and you immediately see the animation that was recorded. Notice that as the animation is playing, you can even change the visual style.

If you are satisfied with the animation, you can save it to a file. In the Animation Preview window, click the Save button. There is also a Save button in the Animations panel on the ribbon.

When you save an animation, AutoCAD displays a Save As dialog. Initially, the only file type available is WMV. But if you click the Animation Settings button, AutoCAD displays the Animation Settings dialog. Here you have much more control over the resulting animation. For example, you can change the visual style to Rendered so that AutoCAD will render each frame of the animation using the selected render preset. In the Resolution drop-down, you can choose the resolution of the animation file. In the Format drop-down, you can choose the animation type as AVI, MOV, MPG, or WMV. And in the Frame Rate drop-down, you can specify the number of frames per second to create in the finished animation. Just remember that if you render each frame of your animation and use the standard frame rate of 30 frames per second, it could take quite a while to produce the animation file.

You can also create a walkthrough or flythrough using the Animation Motion Path tool, which is located in the Animations panel on the Visualize ribbon. This tool enables you to first define a path along which you want the camera to move, so that you can plan your movement in advance.

When you click this tool, AutoCAD displays a Motion Path Animation dialog. The controls in this dialog let you specify a point or path for the camera and target, as well as the frame rate, number of frames, duration, file format, and resolution. You can also select the desired visual style or rendering preset from the Visual Style drop-down. You can click the Preview button to display a preview of the resulting animation. When you click OK, AutoCAD saves the animation to the specified file. Remember that depending on the settings you choose, it could take many hours to compute and save your finished animation.
Using Other Rendering and Animation Tools

In addition to all of the tools built into AutoCAD, you may be able to use other tools to create renderings and animations of your AutoCAD models. For example, if you are using the AutoCAD Design Suite, you can use 3ds Max Design or Autodesk Showcase to create renderings and animations.

The easiest way to accomplish this from within AutoCAD is to use one of the **Suite Workflows**, available from the **Application** menu. Notice that there are several different workflows you can use to create still images, camera animations, and lighting analysis simulations using 3ds Max as well as several workflows for creating presentations using Autodesk Showcase.

If you choose a 3ds Max Design workflow, AutoCAD displays a dialog explaining what the workflow will do, and you can adjust the settings prior to sending the model to 3ds Max.

When you click **Run**, the model will be exported and opened in 3ds Max. You can then use tools in 3ds Max to make additional adjustments and render the scene. Since 3ds Max provides many additional tools, in addition to creating incredible renderings, you can create very sophisticated animations, in which both the camera and objects within the model can move.

But while 3ds Max is incredibly powerful, using it requires mastering additional skills that are quite different from those of AutoCAD.

If you choose a Showcase workflow, AutoCAD again displays a dialog explaining what the workflow will do. When you click **Run**, the model will be exported and opened in Showcase. You can then use the tools in Showcase to make additional adjustments, create finished renderings, and even create and save animations.
Conclusion

That concludes this class on AutoCAD’s Rendering tools. As you have seen, there are a wealth of tools available right inside AutoCAD that you can use to convert your 3D models into finished, photorealistic renderings and animations, complete with lights, materials, and textures.

If you would like to learn even more about rendering tools in AutoCAD, you can download the enhanced CADLearning eBook AutoCAD Rendering – Revealed! Just visit the iTunes bookstore or visit the CADLearning website to learn more.

You can also take my Udemy course “Creating Model Documentation Using AutoCAD.” Simply visit https://www.udemy.com/creating-renderings-with-autocad/.

For comprehensive eBook and video-based instruction for AutoCAD and a wide range of other Autodesk software, visit: www.cadlearning.com